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How to. Set up a RAM Disk 
on an Apple lie or lie 

by Douglas Gum 

This is the second of two articles To enjoy all the speed and power up a RAM disk on Apple lie and 
that describe how to use expand- of AppleWorks, Apple lie and lie lie systems. Everything I say 
ed memory to speed up Apple- owners must install an expanded about RAM disks for the Apple 
Works 4. The previous article memory card, or RAM card, in lie also applies to lie+ computers. 
described how to set up a RAM their system. Fortunately, these Advanced users will realize that 
disk on Apple lias computers. cards are inexpensive; a one there are more efficient ways to 
This article describes how to set megabyte RAM card for an Apple perform some of the operations I 
up a RAM disk on Apple lie and lie costs $60 from NAUG and a describe in this article, especially 
lie computers. 1-megabyte card for a lie or lie 

Plus costs $120. A RAM card 
gives you extra desktop memory 

AppleWorks 4 is so full-fea- and also lets you set up a RAM 
tured that it leaves less than disk that can accelerate spell 

30K of desktop memory available checking and other disk-intensive 
after you load the program onto a operations. [Ed: You will also 
128K system. That small desktop need an expanded memory card 
does not leave much room for to ruh Apple Works 5 on your 
your word processor, data base, or Apple lie, lie, or lie+ system.] 
spreadsheet documents. It also 

The first article in this series limits the number of files you can 
described the benefits of a RAM keep on the desktop, slows down 
disk and showed you how to set your work while AppleWorks 

swaps program segments in and up a RAM disk on Apple IIGs 

out of memory, and does not let computers. [Ed: See "How to Set 

you use macros on your system. up a RAM Disk for AppleWorks 

[Ed: The AppleWorks 4 Ultra- 4" in the October 1994 issue of 
theAppleWorks Forum.]Thisj Macros Player requires at least 
month I will show you how to set 256K of RAM in your computer.] 
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slot RAM disk requires several steps 
not required with a slinky card. '11111111111 · 

Applied Engineering's Ram Works, 
Sequential System's MEG-80z, and 

:--~--:------:--:----:-----:----:----:- Avail: 1024k 
I' , , 1 , , , I' , , I' , , I' , , I' , ' I' , , I' , , 1 Curr: 768k 

Quality Computers' Q-RAM lie are 
examples of aux. slot cards for the 

Bank SWitched 
(Aux. Slot) lie. The most popular aux. slot cards 

I 

Slinky 
(Standard Slot) 

Use Left/Right arrows to adjust the 
amount of memory that AppleWorks will 
use on a slinky memory card. 

for the lie are the no-longer manu-
factured Z-RAM Ultra cards from 
Applied Engineering. Sequential 

Help 

Exit 

AppleWorks fills the ramcard with a file 
that contains the desktop information. 
After using this function, AppleWorks 
will limit the size of the desktop file 
placed on the ramcard so that you can 
use the remaining memory for other 

Systems' RAM lie card works like a 
slinky card, although the company 
says it is technically an aux. slot 
card. RAM lie owners should fol-
low the slinky card directions below. purposes. 

Use Up/Down keys 
to select type of 
memory expansion 

This selection works with RamFactor, 
Apple //e Memory Card, RamExpress, etc. 

If you have a slinky card or you are 
not sure what type of card you have, 

if you use utility programs such as Copy II+ or 
ProSe!. However, the procedures I describe should 
work with any Apple lie or lie system using the 
utilities built into AppleWorks 4. 

Memory Cards 

The steps you follow to set up a RAM disk depend 
on the type of card you install in your computer. 
Apple lie's can use two types of memory cards: 
"peripheral slot" cards (also called "slinky" cards) 
and "auxiliary slot" cards (also called "aux. slot" 
cards). A slinky card installs in one of the peripher
al expansion slots in the Apple lie and automatical
ly configures itself to work as a RAM disk. Apple 
Computer's Apple lie Memory Card and Applied 
Engineering's RamFactor are examples of slinky 
cards for the Apple lie. 

Aux. slot cards install in the auxiliary slot in the lie 
or in the expansion adapter inside the Apple lie. 
These cards access memory in 64K "banks" and 
switch quickly between each bank of memory. In 
addition to configuring AppleWorks to use these 
cards, you must modify the card's RAM disk driver 
software to "lock out" the memory banks you want 
to use as a RAM disk. Thus, configuring an aux. 

continue with the next section, 
"Slinky Card Setup". 

If you have an aux. slot card, you 
will need the RAM disk software 

that came with your memory card. If you do not 
have RAM disk software, you should order the Q- '11111111111 

RAM Test Disk from Quality Computers (Ask for 
product number 99209; $4.95 plus $2 s/h. Quality 
Computers, 20200 Nine Mile Road, Box 349, St. 
Clair Shores, Michigan 48080; (800) 777-3642). 
When you have the RAM disk software, skip to the 
section entitled "Aux. Slot Card Setup" to config-
ure a RAM disk on your system. 

The process that I describe works with 3.5-inch 
and 5.25-inch disk copies of AppleWorks. Hard 
drive owners should start by reading the sidebar 
entitled "If You Have a Hard Drive", which 
describes the procedure to follow on a hard drive
equipped Apple lie or lie system. 

Slin~y Card Setup 

AppleWorks 4 automatically uses all the RAM on a 
slinky card as desktop memory, but the MEM. 
SYSTEM program that comes with AppleWorks 4 
lets you modify AppleWorks so it reserves less 
memory for the AppleWorks desktop. That lets you 
use the remaining memory as a RAM disk. ~ 

Configuring AppleWorks to use a slinky card as a 
RAM disk is a two-part process. First, you must 
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patch AppleWorks so it does not use all the memo
ry on the card for desktop memory. Then you must 
tell AppleWorks which files it should copy onto the 
"disk". 

Slinky Cards: Patching AppleWorks 

Follow these steps to patch AppleWorks so it does 
not use all the memory on the card: 

1. Use a copy of your original AppleWorks pro
gram disk to launch AppleWorks. 

2. Select "Other Activities", "Disk Activities", 
and "Copy a disk" and make another copy of 
your AppleWorks disk. Then quit AppleWorks. 
Users of 5.25-disks only need to back up Disk 
#1. 

3a. If you are using a 3.5-inch AppleWorks disk, 
select "MEM.SYSTEM" from the directory that 
appears on the screen when you quit Apple
Works. [Ed: Also see the sidebar entitled "All 
about MEM.SYSTEM" .] 

3b.lf you are using 5.25-inch disks, insert Apple
Works Disk 4 Side B in a drive and press the 
Tab Key to switch volumes. Select "MEM. 
SYSTEM" and press the Return Key. Since 
MEM.SYSTEM is not on the same disk as 
AppleWorks, the program will ask for the path
name of your AppleWorks disk. Put your 
AppleWorks program Disk #1 in the drive and 
press the Return Key to accept the default path
name /APPLEWORKS. [Ed: Also see the side
bar entitled "All about MEM.SYSTEM".] 

4. With the AppleWorks 4.0 Memory Lockout 
Menu on your screen (Figure 1), select "Slinky 
(Standard Slot)". 

5. The "Avail" (for "Available") value in the 
upper-right comer of the screen is the total 
amount of memory in your system. The "Curr" 
(for "Current") value is the amount of memory 
that will be captured,by AppleWorks. 

You want to leave room for a 256K RAM disk, so 
you should use the Left and Right Arrow Keys to 
make the "Curr" number 256K less than the 
"Avail" value. For example, with 1024K of avail
able memory, you should change the current value 
to 7 68K. That preserves a 256K RAM disk by 
"locking out" 256K of RAM from use for desktop 
memory. 

The volume name for your RAM disk will be 
/RAMx/ where "x" is the slot number where the 
slinky card is installed. For instance, if you 
installed the memory card in slot 4, the RAM disk 
will be named /RAM4/. 

Now continue with these steps to complete the 
RAM disk setup: 

6. Select "Exit". MEM.SYSTEM will automati
cally patch AppleWorks. 

7. Skip to the section entitled "Configuring Apple
Works" at the end of this article. 

Aux. Slot Card Setup 

Creating a RAM disk on an aux. slot card is a four 
stage process: 

• Patch AppleWorks so it reserves memory on the 
card for the RAM disk. 
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• Configure a RAM disk "driver" so it sets up the 
correct size RAM disk on your system. (The 
driver is a program that will set up the RAM 
disk on your aux. slot card each time you 
launch AppleWorks.) 

• Install the "driver" on your AppleWorks disk. 

• Configure AppleWorks so it copies the spelling 
dictionaries onto the RAM disk. 

These steps are necessary because the 6502 and 
65C02 processor in your Apple II can access only 
64K of memory at a time. To access more than 64K 
of RAM, special hardware switches let the comput
er alternate quickly between 64K "banks" of memo
ry in a process known as "bank-switching". Apple
Works 4 normally checks to see how many 64K 
banks of memory are available on your RAM card 
and uses all of them for desktop memory. 

The MEM.SYSTEM program that comes with 
AppleWorks 4 can patch AppleWorks so it uses a 
fixed number of 64K banks of RAM for the desk
top. That leaves the remaining banks available for 
a RAM disk. 

New AppleWorks Startup Disk 

Before you get started, you must create an Apple
Works startup disk that reserves space for the RAM 
disk driver you will add later. ProDOS must be the 
last system file on the disk to avoid conflicts with 
the RAM driver. 

If you are comfortable with disk utility programs, · 
use your favorite utility to prepare a disk named 
I APPLEWORKS with an empty subdirectory called 
/DELETE.ME. Then copy all the files from the orig
inal AppleWorks startup or program disk except the 
files SEG.OO and SEG.XM into the root directory on 
the disk. ProDOS must be the last file copied onto 
the disk. If you use 3.5-inch disks, make certain that 
your utility program copies the I AW.INITS and 
/TIMEOUT subdirectories onto your disk. 

AppleWorks novices should follow these steps: 

1. Launch AppleWorks 4 and choose "Other 
Activities" from the Main Menu. 

2. Select "Disk Activities" from the Other Activi
ties Menu. 

3. Insert a blank disk in the drive and choose "For
mat a disk" from the Disk Activities Menu. 
Accept "/BLANK" as the volume name. 

Now you will create a subdirectory called 
/DELETE.ME on the disk. That will reserve space 
at the beginning of the disk directory for the RAM 
disk driver that you will copy onto the disk later. 
Continue as follows: 

4. Choose "Create subdirectory" and enter the 
pathname "DELETE.ME". AppleWorks will 
present the message "/BLANK/DELETE.ME 
created". 

5. Press the Escape Key three times to return to 
the Other Activities Menu. 

Now you will copy the files onto the disk. Contin
ue as follows: 

6. Choose "File Activities", select "Copy files", 
and choose the "source" and "destination" 
drives from the menus. 

7a.lf you are using 3.5-inch disks, press Apple-
Right Arrow to select all the files on the Apple- ~ 
Works disk. Then use the Left Arrow Key to 
de-select ProDOS. 

7b.lf you are using 5.25-inch disks, press Apple
Right Arrow to select all the files on the Apple
Works startup disk. Then use the Left Arrow 
Key to de-select the files ProDOS, SEG.OO, and 
SEG.XM. Also de-select FINDER.DATA and 
FINDER.ROOT if you find those files on your 
disk. That will make room for the RAM disk 
driver you will copy onto this disk. (SEG.OO is 
the memory driver for 128K machine. SEG.XM 
is the memory driver for a slinky card. Neither 
is needed for this setup. FINDER.DATA and 
FINDER.ROOT may not be on your disk. They 
were on my copy of 4.02 and are of no value to 
non-GSIOS users.) 

8. Press Apple-Return to copy the files. 

9. At the File Activities Menu, choose "Copy 
files" and copy "Pro DOS" from I APPLE
WORKS to /BLANK. That makes ProDOS the 
last system file on the disk. [Ed: To double
check the location of Pro DOS on !BlANK, 
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choose "List all files" from the File Activities 
Menu. ProDOS should be the last file in the 
list.] 

,.,..... 10.1fyou use 3.5-inch disks, press the Escape Key 
to return to the Other Activities Menu. Choose 

ry". Copy the subdirectories "AW.INITS" and 
"TIMEOUT" from I APPLEWORKS to 
/BLANK. [Ed: You have to copy each subdi
rectory separately.] 

11. Remove the I APPLEWORKS disk from the 
"Disk Activities" and then "Copy a subdirecto- drive. 
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.PRO Options 

AppleWorks, the program will 
ask you for the pathname of your W 
AppleWorks disk. Place Apple-
Works program Disk #1 in the 

QDrive.PRO will create a single RAM disk drive in addition to the existing 
ProDOS '/RAM' device. The Dllll8 of this new device is '/QRAM'. You may specify 
which slot and drive you want to em1late for /QRAM. You may also specify the 
amount of your QRam //e memory to assign to /QRAM. 

drive and press the Return Key 
to accept the default pathname: 
"/APPLEWORKS". [Ed: Also 

1. Set the slot and drive for /QRAM 
2. Set the amount of memory for /QRAM 
3. Save the custom changes and create /QRAM 
4. Create /QRAM without saving any, changes 

Please Select: 2 

see the sidebar entitled "All 
about MEM.SYSTEM" .] 

2. Select "Bank Switched (Aux. 
Slot)" from the AppleWorks 4.0 

If you don't want all available memory to be used by /QRAM, you may shrink it 
down to a smaller size in multiples of 64K. By making /QRAM smaller, other 
programs that are capable of using more than 128K (such as AppleWorks) may be 
able to share your available QRam II e memory. 

Memory Lockout Menu (see 
Figure 1). 

3. The "Avail" (for "Available") 
value in the upper-right comer of 
the screen is the total amount of 
memory in your system. The 

llemory available to programs I Total 102411: I llemory available to /QRAM 

(AppleWorks Desktop = 570K) 768K 256K "Curr" (for "Current") value is 
Use arrows to adjust the partition. Press <RE'l'IJRN> when set. the amount of memory that will 

be captured by AppleWorks. 

Now, you will change the name of the volume 
/BLANK to /APPLEWORKS. Follow these steps: 

12.Press the Escape Key to return to the Other 
Activities Menu and select "Disk Activities". 

13. Choose "Rename a disk" and name the disk 
"APPLEWORKS". 

14. Press Apple-Q and then the Escape Key to 
return to the Main Menu. Quit AppleWorks. 

Aux. Slot Cards: Patching AppleWorks 

Now you will use the MEM.SYSTEM program to 
patch AppleWorks so it uses the RAM disk. Follow 
these steps: 

1a. If you are using a 3.5-inch AppleWorks disk, 
select "MEM.SYSTEM" from the directory that 
appears on screen when you quit AppleWorks. 
[Ed: Also see the sidebar entitled "All about 
MEM.SYSTEM" .] 

1b.lf you are using 5.25-inch disks, insert Apple
Works Disk 4 Side B in a drive and press the 
Tab Key to switch volumes. Select "MEM. 
SYSTEM" and press the Return Key. Since 
MEM.SYSTEM is not on the same disk as 

You want to allow room for a 256K 
RAM disk, so you should use the Left and Right _ ~~ 
Arrow Keys to make the "Curr" number 256K less ~ 
than the "Avail" value. For example, with 960K of 
available memory, you should change the current 
value to "704". That preserves a 256K RAM disk 
by "locking out" that amount RAM from use for 
desktop memory. 

4. Select "Exit". MEM.SYSTEM will automati
cally patch AppleWorks. 

Configuring the RAM Disk Driver 

Now you are ready to configure your RAM disk 
driver so it matches the settings you just changed 
in AppleWorks. Your aux. slot memory card proba
bly came with RAM disk software. If so, use that 
software to configure your RAM disk driver. 

If you do not have RAM disk software, you can 
use the Q-RAM Test Disk from Quality Comput
ers. That software works with most memory cards 
including Sequential Systems' popular MEG-80z. 
The following instructions assume that you are 
using the Q-RAM Test Disk to create a RAM disk 
driver for your system: ~ 
1. Make a copy of the Q-RAM Test Disk. 
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2. Insert that copy in a drive and press Apple-Con-
trol-Reset to warm-boot the computer. [Ed: Do 
not use the original Q-RAM Test Disk. This 
operation changes the QRAM.SYSTEM and 
QRAM.DRIVE.PRO files on the disk.] 

3. At the Main Menu, choose "Install RAM Disk" 
and then "Customize Ramdisk" to display the 
QDrive.Pro Options screen (see Figure 2). 

4. Choose "Set the slot and drive for /QRAM". Set 
the slot to "3" and the drive to "1". Other values 
for slot and drive numbers will work, but slot 3, 
drive 1 is the least likely to interfere with other 
disk devices. 

5. With the QDrive.Pro Options Menu on your 
screen, choose "2. Set the amount of memory 
for /QRAM". Then use the Arrow Keys to set 
the /QRAM memory to 256K. Note that the 
amount of memory used for the Apple Works 
desktop increases as you reduce the size of the 
RAM disk. [Ed: The values for "Total" and 
"Memory available to programs" are 64K 
higher than those displayed by the MEM.SYS-
TEM program. That is because MEM.SYSTEM 
does not count the first 64K bank of memory.] 

6. At the QDrive.Pro Options Menu, choose "Save 
the custom changes and create /QRAM" and 
respond "Y" to the "Save the custom changes to 
QRAM.SYSTEM also (YIN)?" prompt. 
QRAM.SYSTEM is the driver that will create 
the 256K RAM disk when you boot up your 
system. 

7. Choose "Exit to System" from the Main Menu. 

Copying the RAM Disk Driver onto AppleWorks 

QRAM.SYSTEM has set up a 256K RAM disk on 
your computer, but an aux. slot card RAM disk is 
volatile; you must re-create the "disk" each time 
you turn on your computer. The easiest way to do 
that is to copy the RAM disk driver onto your 
AppleWorks disk. If you make QRAM.SYSTEM 
the first system file on the disk, ProDOS will run 
the program automatically and re-create the RAM 
disk each time you launch AppleWorks. 

Advanced users should delete the /DELETE.ME 
subdirectory from their new AppleWorks disk and 

copy QRAM.SYSTEM onto the disk. AppleWorks 
novices should follow these steps to copy the driv
er onto their AppleWorks disk: 

1. Launch AppleWorks and choose "Other Activi
ties" from the Main Menu. 

2. Select "File activities" and then "Delete files". 

3. Navigate to the /APPLEWORKS disk, press the 
Right Arrow Key to select the DELETE.ME 
subdirectory, and press Apple-Return to delete 
the subdirectory. That will erase the directory 
and preserve a space at the beginning of the 
I APPLEWORKS directory for your RAM disk 
driver. 

4. From the File Activities Menu, choose "Copy 
files". 

5. Copy"QRAM.SYSTEM" from the Q-RAM 
Test Disk to your AppleWorks disk. 

6. Quit and restart AppleWorks by warm-booting 
your computer. Your system should boot into 
ProDOS and launch QRAM.SYSTEM. 
QRAM.SYSTEM will then display a message 
indicating that it created a 256K RAM disk in 
Slot 3, Drive 1. [Ed: QRAM.SYSTEM also 
reports that it created a 64K RAM disk in Slot 
3, Drive 2. That is the first 64K bank of memory 
in your computer; it is not a customizable RAM 
disk.] 

Then your computer will load the copy of Apple
Works that you patched with MEM.SYSTEM earli-
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Src Type BUp Path 

============================================================================== 
/APPLEWORKS/CUST.DICTIONARY 
/APPLEWORKS/MAIN DICTIONARY 
/APPLEWORKS/FONTS 

File 
File 
Dir 

/QRAM 
/QRAM 
/FONTS 

er. Follow these steps to confirm that the RAM disk 
is configured properly: 

1. From the Main Menu choose "Other Activities". 

2. Choose "Change current disk or ProDOS pre
fix". At the Change Current Disk Menu, a drive 
named "RAMDisk (Slot 3)" should appear in 
the list of available drives. 

3. Press Apple-Q and then the Escape Key to 
return to the Main Menu without making any 
changes to the current disk setting. [Ed: If the 
RAM disk did not appear in the list in step #2, 
quit AppleWorks, reboot your system, and 
restart AppleWorks.] 

11/06/94 2:00 

4. If you are using 5.25-inch disks select "Other 
Activities", "Disk Activities", then "Rename a 
disk" to re-name "/DICTIONARIES" to "/DIC
TIONARY". For AppleWorks 4.3 the dictionar
ies must be either on the same disk as Apple
Works or on a disk or directory named "/DIC
TIONARY". The dictionary copy routine for 
AppleWorks 4.3 (SEG.DC) was programmed 
with a different pathname than the distributed 
copies of the dictionary disk. This step recon
ciles the pathname difference. 

Configuring AppleWorks 

Now that you created the RAM disk, it is time to 
configure AppleWorks so it pre-loads and looks for 
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Conclusion 

Other Activities 

Standard Settings 

Spelling Checker 

1. Standard custom dictionary CUST.DICTIONARY 

Setting up a RAM disk on an Apple lie 
or lie is neither fast nor easy. But once 
you patch AppleWorks and configure 
your system for the "disk", you will 
appreciate the speed and convenience 
you get from running your spell check
er and thesaurus with your RAM-based 
files. Like many of life's conveniences, 
you will wonder how you ever lived so 
long without your no-cost RAM-based 
"accelerator". 

2. Standard spelling method From a list 

3. Standard summary setting Screen 

4. Copy dictionaries at startup Yes 

5. Location of dictionaries /RAM4/ 

the spelling checker dictionaries on that "disk". 
Follow these steps: 

1. Launch AppleWorks and press Apple-Q and 
then Apple-S to access the Standard Settings 
Menu. 

2. Choose "Spelling Checker options". 

3. At the Spelling Checker Menu, change "Copy 
dictionaries at startup" to "Yes". That tells 
AppleWorks to copy the dictionaries onto your 
RAM disk when you launch the program. 

4. Change the "Location of Dictionaries" to the 
ProDOS volume name assigned to your RAM 
disk. (Usually this is "/RAM4/" or "/QRAM/".) 
Your screen should look like the example in 
Figure 3. 

5. Press the Escape Key to return to the Main 
Menu. AppleWorks will save your changes. 

6. Tum off your system, count to ten, and boot 
your computer with AppleWorks. 

At startup, the messages "Copying CUST.DIC
TIONARY" and "Copying MAIN.DICTIONARY" 
should appear if you load AppleWorks from a 3.5-
inch disk. If you use 5.25-inch disks, AppleWorks 
will prompt you to insert the "/DICTIONARY" 
disk. 

[Douglas Gum is a contract program
mer and the owner of Office Produc
tivity Software. He is the author of 
TimeOut Shrinklt Plus and many other 
AppleWorks enhancements.] 

[The author thanks Dr. Cynthia Field, 
Dr. Warren Williams, Robert Boucher, 

and Robert Hollingsworth for testing the proce
dures described in this article.] 
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How to Make Holiday Mugs 
with AppleWorks 

by Cynthia E. Field 

This article is part of a continuing series that describes projects you can create with Apple
Works and TimeOut SuperFonts. This month you will learn how to make personalized plas
tic mugs for the holidays. 

The holidays are an exciting, busy, and 
often expensive time of year. That makes 

this month's project so appealing. In less than 
an hour, you can create a holiday design to 
decorate personalized plastic mugs like the 
examples in Figure 1. 

The baby mug with its spill-proof lid and the 
adult-size mug each cost $2.50. You can fill a 
mug with goodies for a total cost of less than 
$5 per personalized, attractive gift. 

Figure 2 depicts the designs you can create to 
personalize the mugs. Figure 3 contains the 
AppleWorks document that you use with 
TimeOut SuperFonts to print the design. 

Overview 

The mugs are easy to make, whether you are 
eight years old or eight decades young. You 
create a simple design with text and graphics 
using AppleWorks, TimeOut SuperFonts, and 
TimeOut Paint. Then you print the design 
and enhance it with color. Finally, you insert 
the completed design between the outer 
transparent part of the mug and its white lin
er. Snapping the two plastic parts of the mug 
together makes the container leakproof. 

To complete the gift, you can put grocery 
store coupons or a gift certificate in the baby 
mug. You can fill the adult mug with holiday 
candy, coffee beans, or gourmet tea bags. The 
possibilities are limited only by your imagi
nation and the recipient's interests. 

JAMIE'S r?IRST ~HRSTMAS 1994 
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• TimeOut SuperFonts. 

• TimeOut Paint. 

Figure 3A: SuperFonts Setup - Part 1 • Publish It! or any other double 

REVIEW/ADD/CHANGE Escape: Main Menu high-resolution clip art. 
=====<====<====<====<====<====<====<====<====<====<====<====<====<====<====<= 
<1=/CEFE1/APPLEWORKS.3.0/FONTS/SANFRANCISC0.18>1 
<p1= /naug /pic. xmas>l. 

--------centered 
<1>S E A s 0 N I s G R E E T I N G Sl 

<p1>1 

Line 7 Column 1 

Figure 38: SuperFonts Setup- Part 2 

10/25/94 2:45 

Choosing the Font 

My mug includes a lively, festive 
font and a single holiday graphic. 
Follow these steps to select the 
font: 

1. Launch AppleWorks and start a 
new word processip.g file from 
scratch. Name the file 
"MUGS". Save the template 
frequently as you complete the 
project. 

REVIEW/ADD/CHANGE Escape: Main Menu 
2. Insert a SuperFonts Load Font 

command at the beginning of 
the document. Use Figure 3A as 
a guide. Remember that the 
Load Font command must be 

=====<====<====<====<====<====<====<====<====<====<====<====<====<====<====<= 
<1=/CEFE1/APPLEWORKS.3.0/FONTS/SANFRANCISC0.18>1 
<p1=/naug/pic.xmas>l 

--------Centered 
<1>M E R R Y C H R I S T M A Sl 

<pl>l 

Line 7 Column 1 

What You Need 

You need the following supplies and software to 
complete this project: 

• Three-part baby mugs or two-part adult mugs. 
You can find the mugs in local craft stores or 
you can order the mugs from The Richman Cot
ton Company (see the Company List). 

• A method for coloring your designs. You can 
color the designs by hand with colored pencils, 
pens, or felt-tipped markers. Other alternatives 
include foil-stamping and embossing (see the 
"Holiday Color" sidebar for ideas and instruc
tions). 

• Scissors, a ruler, and glue. 

• AppleWorks 2.0 or later. 

10/25/94 2:45 

the first line in the document. ~ 

If you use AppleWorks 2.0, you 
must type the Load Font command 
manually. Be sure you include the 
complete pathnarne to the font. 

If you use a later version of Apple
Works, press Apple-Escape and use 
PickFonts to automatically enter 

the appropriate command and path in the MUGS 
template. 

Use the SanFrancisco.l8 font to create the message 
on the mugs. SanFrancisco, which comes with 
TimeOut SuperFonts, is appropriate for the holi
days. Later you can experiment with other fonts for 
the mugs you create for different occasions. 

Selecting Graphics 

If you have TimeOut Paint, you can add double 
high-resolution graphics to your mug. 

I used the Christmas symbols from the collection 
of graphics that carne with Publish It!, the popular ~ 
Apple II desktop publishing program. If you do not 
have Publish It!, browse through your clip-art col-
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lection and choose an appropriate picture for 
your mug. 

Now you will use TimeOut Paint to select and 
modify the graphic. Continue with these steps: 

1. Press Apple-Escape and choose "Paint" to 
launch TimeOut Paint. 

2. Select "Open" from the File Menu. [Ed: 
If you do not have a mouse, use the 
Arrow Keys to move the Arrow Pointer. 
(Holding down the Apple Key speeds up 
the pointer.) Then press the Solid Apple 
Key or Option Key to display the menu.] 

3. Navigate to the file that contains the 
graphic. (If you are using the Publish-It! 
graphics, navigate to the XMAS file.) 

Most files contain a collection of graphic 
images; if the file you select contains a single 
graphic, use the Marquee Tool to select the graphic 
and skip to step #8. 

Continue with these steps to select and save the 
graphic: 

4. Select "Marquee" from the Tools Menu. Put the 
mouse near the top left-hand comer of the first 
of the five Christmas symbols (which include a 
holiday bulb, stocking, tree, bell, and gift pack-
age) and press the mouse button. Drag the 
mouse to the right and downward to create a 
frame around the five symbols. Then release the 
button. [Ed: If you do not have a mouse, hold 
down the Option Key as you use the Arrow 
Keys to draw the marquee frame.] 

5. Choose "Copy" from the Edit Menu. 

6. Choose "New" from the File Menu and click on 
"No" when Paint asks if you want to save your 
changes to the existing file. 

7. Choose "Paste" from the Edit Menu. Paint will 
display the marquee frame to depict the place-
ment of your graphic. 

8. Use the mouse to drag the graphic into position 
about two-thirds of the way down your screen 
(see Figure 4). 

Now you will save the graphic in a new file. The 
TimeOut Paint "Save As ... " dialog does not let you 
change directories, so here is a workaround that 
lets you select a destination for your saved graphic: 

9. Insert a formatted disk in your drive. Then 
select "Open" from the File Menu, click on the 
Disk Button and navigate to that disk. 

lO.Click on "Cancel". That closes the dialog box 
and sets the destination you specified as the 
destination for your saved graphic. 

11. Choose "Save As ... " from the File Menu. Name 
the graphic "PIC.XMAS". Write down the com
plete pathname to the file. Then click on the 
Save Button. 

12.Select "Quit" from the File Menu to return to 
AppleWorks. 

Completing the Template 

Now you are ready to add the Load Picture com
mand and enter the text in your AppleWorks tem
plate. Follow these steps: 

1. Move the cursor to line 2, the line immediately 
under the Load Font command. 

2. Type the Load Picture command in Figure 3A. 
Change the text so it specifies the complete path 
to your PIC.XMAS graphic. Then press the 
Return Key to proceed to line 3. 
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3. On line 3 press the Return Key to enter a blank 
line. 

4. On line 4, press Apple-0 and center the design. 

Next, you will place the picture and enter the text 
for your mug. Follow these steps: 

la. If you are creating a baby mug, enter "<l>J A 
MIE'S FIRST CHRISTMAS 19 
9 4" on line 5. For readability sake, enter a 
space between each letter in a word and three 
spaces between words. If the message exceeds 
one line, shorten it to fit the mug. 

lb. If you are creating an adult mug, enter "<l>S E 
A S 0 N ' S G R E E T I N G S" on line 5. 
Enter a space between each letter in a word and 
three spaces between words. Use Figure 3A as a 
guide. [Ed: This is the front of the adult mug. 
You will create the back of the mug later. 
Because adult mugs are larger than baby 

mugs, you must create the design as two panels 
that you will glue together before assembling 
the mug.] 

2. On line 5, enter "<pl>". 

3. Save the template. 

Previewing and Printing 

Now you will preview the template. Follow these 
steps: 

1. Press Apple-Escape and launch SuperFonts. 

2. Press the Return Key to print from the begin
ning of the document. 

3. Select "The screen" in response to the "Where 
do you want to print the file?" prompt. 

4. Type "H" and press the Return Key twice to 
specify high quality printing and to preview 
your mug. 

5. Press the Space Bar to return to AppleWorks. 

6. When you are satisfied with your mug design, 
print a copy. 

7a. If you are creating a baby mug, you are ready to 
embellish your design by using one of the 
options in the "Holiday Color" sidebar. Then 
continue with "Assembling the Mug" below. 

7b. If you are creating an adult mug, move the cursor 
to line 5 and press Apple-Y to yank the existing 
text. Then enter "<l>M ERR Y CHRIST 
M A S" as the text that will appear on the back 
of your mug. Use Figure 3B as a guide. Do not 
change any other elements of the template. 

8. Repeat steps #1 to #6 above to preview and 
print the template. Then embellish your design 
by using one of the options in the "Holiday Col
or" sidebar. 

Assembling the Mug 

Now you are ready to assemble the mug. If you are 
creating a baby mug, all you have to do is trim the 
design so it fits the mug. If you are creating an 
adult mug, you must trim the front and back panel 
printouts and glue them together. Follow these 
steps to complete your mug: 
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la. If you are creating a baby mug, cut out the 
design so it is 3-inches high. You can leave the 
width at 8.5-inches. Any excess will be hidden 
when you insert the design into the mug. 

lb. If you are creating an adult mug, trim both of 
the printed panels so that each is 3 5/8-inches 
high. Be sure that the text destined for the front 
of the mug ("SEASON'S GREETINGS") and 
the back of the mug ("MERRY CHRISTMAS") 
will line up evenly when the two pieces are 
glued together. Trim either the front or back 
panel so it is 4-inches wide. Leave the other 
panel 8.5-inches wide. 

Position and glue the narrower panel on the wider 
one. Make sure that the composite design does not 
exceed a 10-inch maximum width, which is the cir
cumference of the finished mug. 

2. Place the design in the transparent, outer part of 
the mug. Adjust the design so the text and 
graphics show clearly and the seams are unob
trusive. Make sure that any unprinted, excess 
length is hidden behind the printed parts of the 
design. 

3. Put the mug on the floor or a strong table, insert 
the white mug liner, and snap it firmly into ....JI 
place. 

Now you are ready to fill the mug with goodies and 
wrap it as a gift. 

Conclusion 

A mug makes an ideal gift for your child's teacher, 
the mail carrier, friends at work, or fellow club 
members. This is a gift idea that the recipient will 
use throughout the new year. 

[Dr. Cynthia E. Field has been doing things that 
can't be done on Apple II computers since 1982. 
She was the author ofinCideriA+'s popular 
"Press Room" column and is the Contributing 
Editor of the AppleWorks Forum.] 

[Ed: Working copies of the MUGS template and 
some useful holiday graphics appear on this 
month's issue ofNAUG on Disk, which costs $10 
from NAUG. The templates require AppleWorks 
2.0 or later enhanced with TimeOut SuperFonts. 
NAUG on Disk requires a 3.5-inch drive.] 

~11JJ£lJ191!!ll1 
NAUG Discount on Contacts GS 

NAUG members who use AppleWorks GS and oth
er 16-bit applications will appreciate this special 

discount on Contacts GS, an Apple lias New Desk 
Accessory that provides a Rolodex-style name, 
address, telephone number data base, and telephone 
dialer that you can access within any standard GS/OS 
application. 

Contacts GS also includes ContactMover, a TimeOut 
application that automatically transfers data between 
Contacts GS and AppleWorks Classic. ContactMover 
requires AppleWorks 4.x or AppleWorks 3.0 enhanced 
with UltraMacros 3.1 or Ultra 4. 

Contacts GS lists for $35 but costs NAUG members 
$20 plus $3 s/h ($5 s/h outside the United States). 
Include a check or money order payable to Joe Kohn 
with your order; the company does not accept credit 
cards or purchase orders. 

[Shareware Solutions II, 166 Alpine Street, San 
Rafael, California 94901.] 
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A Macro Alternative to 
TimeOut PickFonts 

by Keith Johnson 

I f you use SuperFonts, you probably know about 
PickFonts, the TimeOut application that lets you 

insert font pathnames by choosing the fonts you 
want to use from a list. PickFonts sure beats typing 
those font pathnames by hand. 

But PickFonts has three drawbacks. 

1. The program lists every font in your Fonts 
directory. If you have a lot of fonts in the direc
tory, finding and selecting the ones you want 
can be tedious. 

,..... 2. PickFonts enters your fonts in the order they 
occur in the directory, not in the order that you 
select them. PickFonts will not let you re
sequence the fonts so your most-used font 
is in the first position. 

2. Compile the file and save it as your default 
macro set. [Ed: For step-by-step directions for 
adding the macro to your default macro set, 
see the sidebar entitled "How to Add a 
Macro" in the Aprill994 issue of the Apple
Works Forum.] 

3. Prepare an AppleWorks word processor docu
ment called "FontList" that lists all the font 
names you want available for SuperFonts (see 
Figure 2). You need not include all the fonts in 
your Fonts directory, nor must you list them in 
alphabetical order. (You might prefer to list 
them in their order of importance to you.) Spell 
the font names exactly as they appear in the 

Fonts directory. Include 

3. The original version of PickFonts will not 
work with AppleWorks 4. 

This month's macro gives you the features you 
like in PickFonts without these problems. It 
loads a custom file that lists the fonts you use 
most, lets you choose them in any order, and 
inserts the pathnames into your document in 
the order that you choose them. 

" Here is a way 
to simulate 
PickFonts with 
Apple Works 4." 

only the names of the 
fonts, not their complete 
pathnames. Save this file 
in the same directory 
you use to store your 
fonts, which is defined 
in string variable $2 in 

The macro requires AppleWorks 4 and Ultra 4. 

How to Use the Macro 

1. Type the macro in Figure 1 into your macro 
file. Although I assigned <ba-F> to the macro, 
you can define the macro to use any key combi
nation you like. Replace the pathname 
"/HD/AW4/FONTS" in the macro with the path 
to your Fonts directory. The macro uses several 
dot commands; make certain you type the peri
od before each command name. 

the macro. You can 
update and save this list at any time. 

4. Now you will use the macro. Create a new word 
processor file for your document. Press <ba-F>. 
If you have fewer than 12 files on your desktop, 
the macro will load the FontList file. If you 
already have 12 files on the desktop, the macro 
will ask you to remove a file before proceeding. 

Move the cursor up and down the list with the Up 
and Down Arrow Keys. Choose your fonts by 
pressing the Right Arrow Key when the cursor is 
on the desired line; the characters"->" will appear 
in front of each font you choose. Press the Return 
Key when you are done. The macro will display 
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Figure 1: Macro that Inserts Font Names 
<ba-F>:<awp>< 
• deskcount 7 
if z = 12 bell 

{ Define the macro. 
{ Check the number of files on the desktop • 
{If 12 files, sound a beep ..• 

} 

} 

} 

msg ' You must remove a file from the desktop! (Press a key) ' : { ••• display this warning message ••• } 
k = key : { ••• wait for a keypress. • • • } 
msg nn : { ••• erase the message and... } 
endmacro : endif : 

insert : 
$1 = .peekstr $ba99 : 
$2 = "/HD/AW4/FONTS" 
.setdisk $2 : 
$3 = .peekstr $c56 
$4 : II.) II : 

esc : rtn : rtn 
$9 = 11 FontList 11 

rtn : 
oa-1 : 
n = 19 

z = 299 

{ ••• stop the macro. 
{ Turn on the insert cursor. 
{ Save the current path. 
{ Define the pathname for font list. 
{ Set the active pathname. 
{ Save the current filename. 
{ Define the marker characters. 
{ Add a file from the current disk. 

find: {Search for the FontList file ••• 
{ ••• and load it. 
{ Go to the top of the list. 
{ Initialize the name counter. 

Change this to match your system. 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

msg 11 Use 11 + &J& + • and • + &K& + 11 arrows to move, 11 + &U& + 11 to select. Return to end; Esc to stop. 11 : 

begin : 
k = key : 
if k = 19 or k = 11 

print chr$ k : rpt : endif 
if k = 21 then $(n) = cell : 

print $4 : 
first : 
n=n+1: 
rpt : endif 

if k = 13 then exit : endif 
if k = 27 msg 11 11 : endmacro 

rpt : 
oa-Q : $9 = $3 : find : rtn : 
.zoomin : 
oa-1 : 
rtn : up : 
j = 1 : n = n - 1 : 
for i = 19 to n step 1 

{ Display the instructions. 
{ Begin a loop that stores the font names. 
{ Get a keypress from the user. 
{ If it's an Up or Down Arrow ... 
{ ••• pass it on to AppleWorks. 
{If it's a Right Arrow, store the name ••• 
{ ••• type the marker ••• 
{ ••• move the cursor to the start of the line ••• 
{ ••• increment the name counter and ••• 
{ ••• repeat the loop. 
{ If the user pressed the Return Key, exit the loop. 

endif : { If the user pressed the Escape Key, stop. 
{ Otherwise, repeat the loop. 
{ Return to the original file. 
{ Zoom in to show the printer options. 
{ Go to the beginning of the file. 
{ Provide space for the font names. 
{ Initialize the counters. 
{ Start a loop that prints the font names. 

print "<" + str$ j + 
j = j + 1 

··=" + $2 + 11 /" + $(i) + "> 11 : rtn : { Print a font name in the proper format. 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

} 

next i : 
.setdisk $1 
esc : 
$9 = "FontList 11 >4<rtn 
find : rtn>4<rtn>Y< 
$9 = $3 : oa-Q : find 
del>! 
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rtn 

{ Increment the font number. 
{ Repeat the loop. 
{ Re-set the active AppleWorks pathname. 
{ Go to the Main Menu. 
{Remove the FontList file from the desktop ••• 
{ ••• without saving it. 
{ Return to the original file. 
{ Delete the extra Return. 
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Figure 2: Sample Font List File 
File: FontList REVIEN/ADD/CHANGE Escape: Main Menu 

If you press the Escape Key while 
choosing font names, the macro stops 
immediately; you will have to remove 
FontList from the desktop manually. 

=====<====<====<====<====<====<====<====<====<====<====<====<====<====<====<= 
HELVETICA.10 
HELVETICA.12 
HELVETICA.18 
TIMES.10 
TIMES.12 
AUST.ECON.10 
AUST.ECON.12 
KLINGON.18 

The macro displays"->" in front of 
each font you choose. It's up to you to 
avoid choosing a font twice. You could 
add error-checking to prevent this, but 
that adds unnecessary complexity to the 
macro. 

When you are done, the macro will try 
to re-set the active path in AppleWorks 
to the path that was active before you 
ran the macro. This will work if a path-

-----------------------------------------------------------------------------
Type entry or use d commands Line 5 Column 1 

your original file, enter the font names in the order 
you chose them in the proper format for Super
Fonts, and will remove the FontList file from the 
desktop. You can stop the macro when the font list 
is visible by pressing the Escape Key. 

How It Works 

The <ba-F> macro uses the <cell> command to 
read the font names you chose. (<cell> stores an 
entire line of a word processor file as a string vari
able.) The macro stores these names in successive 
string variables, starting with $10. Ultra 4 accepts 
string variables in the range $0 to $99, so you can 
enter up to 90 font names. (If you need more fonts 
than that, you're probably abusing SuperFonts!) 

The macro assumes that the FontList file is not 
already on the desktop; it doesn't even check for its 
presence. This will only be a problem if you just 
edited the list, so be careful to save and remove the 
FontList file before you use the macro. You could 
add a step to check for its presence, but that is 
unnecessary for most users. 

The macro adds the FontList file to the desktop, 
forces a zoom-in, and inserts a Return before jump
ing to the top of the document. That ensures that 
the font names appear above any printer options at 

,....... the beginning of the file; you can use the macro 
even if you already entered text in the document. 

09122194 12 :21 name (rather than just a slot and drive) 
was active. But this may not succeed if 
the active path was a slot and drive; you 

may have to re-set the path manually. 

Generally, you should save the FontList file in the 
directory that contains your fonts. If you store the 
file in a different directory, you must change the 
value assigned to $2 in the macro. 

Finally, you can run the macro more than once in a 
document, but the macro always starts numbering 
at "1". You will have to re-number the font names 
manually if you run the macro a second time in the 
same document. 

Conclusion 

SuperFonts is one of the most popular add-ons ever 
released for AppleWorks. As you will see when 
you try it, this month's macro makes it easier than 
ever to use this popular AppleWorks add-on to 
print attractive documents. 

[Keith Johnson is Associate Director of the Fleis
chmann Planetarium at the University of Nevada.] 

SeasonS greetings * * 
-~From lfOJLr {rientf~ at the ~ ~ 

i}lj_~tio~a[ 5ipp[e•Wor/(s 'Use1:~ yroup ·~« 

AppleWorks Forum December 1994 Page 19 



New Disks in the NAUG Public 
Domain Library 

AppleWorks 4.3 Patch Disk 

NAUG's new AppleWorks 4.3 Patch disk contains 
four sets of important patches and bug fixes for 
AppleWorks 4.3: 

MergeFix: Fixes a bug in AppleWorks 4.3 that 
causes problems with unfilled fixed-length mail 
merge fields. 

ReportWriter 4.3 Updater: Updates ReportWriter 
so it runs with AppleWorks 4.3. 

SEG.DB: An updated SEG.DB file for Apple
Works 4.3. You should use this file if your 
SEG.DB file is dated before August 28, 1994. 

MEM.SYSTEM: Replaces the defective version 
of this program that shipped with some copies of 
AppleWorks 4.3. See the article entitled "How to 
Set Up a RAM Disk on an Apple lie or lie" for 
more information about MEM.SYSTEM. 

NAUG Statistics.Ol 

Four easy-to-use AppleWorks templates that com
pute exponential regression, linear regression, Pear
son product-moment correlation, and Spearman 
rank-difference correlation. The author, Woody Lis
wood, assumes that you know the assumptions and 
uses for these four statistical procedures. These 
templates are also an excellent model for Apple
Works users who want to learn how to create 
spreadsheet templates that analyze data. 

NAUG EDUC.02 

Three useful templates for classroom teachers: 

Classroom Attendance: Maintains student atten
dance records in accordance with state guidelines. 

Gradebook Template: A sophisticated, easy-to
use gradebook that tracks student scores and 
assigns grades. Requires AppleWorks 3.0 or later. 

Lined Paper: Prints lined paper you can use for 
tests and other assignments. 

ProDesk Plus 4.1 

NAUG is now shipping version 4.1 of ProDesk 
Plus, Dr. Helge Malmgren's popular 8-bit program 
selector and utilities for Apple lie, lie+, lias, and 
enhanced Apple lie computers. 

ProDesk Plus lets you view text, AppleWorks 
word processor, and high resolution and double 
high resolution graphic files without the applica
tions used to create those files. Utilities included 
with ProDesk let you create subdirectories, delete, 
rename, lock/unlock, copy, and find files. ProDesk 
also displays the time on any Apple II equipped 
with a ProDOS-compatible clock and includes a 
built-in screen saver to protect against screen 
bum-in. Finally, the program offers an alarm 
clock, a pop-up help screen, and a file library sys- _ ,JJ 

tern that makes it easy to keep track of the files on ~ 
your disks. 

This new version of Pro Desk calculates the total 
size of the files in every subdirectory, offers an 
improved library function, handles long lists of 
online volumes, offers extended mouse control, 
and fixes all known bugs in the earlier versions of 
Pro Desk. 

ProDesk Plus is shareware; you send the author 
$20 after you get the disk from NAUG. (The share
ware fee is a one-time payment. Registered Pro
Desk users do not pay an additional shareware fee 
for this upgrade.) 

How to Get Disks 

Unless otherwise specified, all NAUG disks come 
in both 5.25-inch ($4) and 3.5-inch ($6) formats. 
Add $2 s/h per order to all prices. All disks are 
covered by NAUG's "satisfaction guaranteed or 
your money back" policy. NAUG accepts Visa and 
MasterCard. Order from NAUG Public Domain 
Library, Box 87453, Canton, Michigan 48187; """"' 
(313) 454-1115; Fax: (313) 454-1965. 
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Special Discount Offers 
for NAUG Members 

1040Works 

With tax season soon upon us, NAUG members 
will appreciate this special discount on 1 040Works, 
a set of professionally developed Apple Works 
spreadsheet templates that prepare your Federal 
Income Tax returns. The 1 040Works templates 
help you collect and enter data, do all the necessary 
computations, and print completed tax forms that 
you can mail to the government. 

The 1994 version of 1 040Works prepares 23 of the 
most widely used Federal Income Tax schedules 
and forms (Forms 1040, 2106, 2119, 2210, 2441, 
3903,4562,6251,8283,8582,8582-CR,8606, 
8615, 8814, and 8829, and Schedules A, B, C, D, 

f"" E, F, R, and SE). 

1040Works lists for $34.95. NAUG members can 
buy 1040Works for $29.95 plus $3.50 s/h. Owners 
of earlier versions can update to the 1994 templates 
for $24.95 plus $3.50 s/h. 1040Works requires an 
Apple II or Apple II -compatible computer running 
AppleWorks 2.0 or later and enough memory to 
provide at least a 256K AppleWorks desktop. 

NAUG members can also get significant discounts 
on the 1995 1 040Works Tax Planner, a comprehen
sive tax planning package for AppleWorks. The 
1 040Works Tax Planner estimates your Federal 
Income Tax for 1995-1997, determines whether 
you will be affected by the Alternative Minimum 
Tax, calculates your correct withholding and your 
quarterly tax payments, and compares alternative 
financial strategies to help minimize your federal 
tax liabilities. The 1 040Works Tax Planner can 
help you time your investment decisions to maxi
mize your after-tax yields. 

The 1040Works Tax Planner lists for $29.95; 
NAUG members can buy the Tax Planner for 
$26.95 plus $3.50 s/h. The Tax Planner costs 
$19.95, including shipping if ordered with 
1 040Works or with a 1 040Works update. Owners 

of last year's version of the Tax Planner can update 
to the 1994 Tax Planner for $19.95 plus $3.50 s/h. 

NAUG will ship 1040Works and the 1040Works 
Tax Planner in late February 1995. Owners of ear
lier versions should use the order forms they will 
receive in late December 1994. 

Both 1040Works and the 1040Works Tax Planner 
are covered by NAUG's "satisfaction guaranteed 
or your money back" policy. Indicate whether you 
want 5.25-inch or 3.5-inch disks when you order. 
NAUG accepts Visa and MasterCard. 

[NAUG, Box 87453, Canton, Michigan 48187; 
(313) 454-1115; Fax: (313) 454-1965.] 

Macintosh Tax Software 

NAUG members who own Macintosh computers 
will appreciate these special NAUG discounts on 
MaclnTax and TaxCut, two high quality stand
alone Federal Income Tax preparation programs for 
the Macintosh. 

MaclnTax and TaxCut are similar products. Both 
programs suggest the forms you should file, use 
interview-like procedures to help you complete 
your work, offer tax-saving tips and suggestions, 
automatically display the schedule that underlies 
each line on your Form 1040, offer extensive on
line help, and print complete forms that you can 
submit to the IRS. 

MaclnTax and TaxCut (which list for $69.95 and 
$79.95 respectively) each cost NAUG members 
$29.95 (plus $6.50 s/h). Order MaclnTax directly 
from Intuit and indicate that your customer code is 
"41949". Order TaxCut from MECA and ask for 
extension "T626". 

[Intuit: (800) 964-1040; Fax (USA): (800) 756-
1040; Fax (lntl.): (602) 295-3095.] 

[MECA: (800) 288-6322; Fax: (800) 944-6322.]t'7A 
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Letters to NAUG 

Printing Problems with AppleWorks 

Dear Cathleen: 

I enjoy the new features in AppleWorks 4, but I 
have an occasional problem printing on my Image
Writer II. Every once in a while the printer skips 
half a page or so instead of moving to the top of the 
next page. Is this a bug in AppleWorks? 

Rosemary Webster 
Carrollton, Texas 

[Ed: The problem is with your "top of page com
mand" setting. And it affects all versions of Apple
Works, not just Apple Works 4. 

Like most modern printers, the Image Writer II 
accepts a top of page command that tells your 
printer to skip to the top of the next page. Your 
Image Writer counts the number of lines it prints 
on each page and automatically skips to the top of 
the next page when it receives the appropriate 
command. 

AppleWorks also counts lines as it prints and 
sends a top of page command after it transmits the 
number of lines you specified for the page. Most 
of the time your printer and Apple Works are "in 
sync" and the printer skips to the top of the next 
page. Occasionally, the line counts in your printer 
and in Apple Works do not match and your printer 
skips too many lines. 

The easiest way to fix this problem is to set 
AppleWorks' "accepts top ofpage command" set
ting to "No". That gives AppleWorks complete 
control over your page breaks. When Apple Works 
needs a new page, it will tell your printer how 
many blank lines to skip to position the new page 
in the printer. 

For more reliable operation, AppleWorks users 
should set the "Accepts top ofpage command" to 
"No" for all versions of AppleWorks and for all 
continuous feed printers. 

Follow these steps to change this setting for 
AppleWorks 4: 

1. With the AppleWorks Main Menu on your 
screen, select #5, "Other Activities". 

2. Choose #5, "Select standard settings for 
AppleWorks" from the Other Activities Menu. 

3. Select# 12, "Printer settings" from the Stan
dard Settings Menu. 

4. Select "4", 'J5", or "6" to change your printer 
specifications. 

5. Select #2, "Accepts top of page commands" 
from the Change a Printer Menu. 

6. Press "Y" in response to the "Change the val
ue?" prompt. 

7. Press Apple-Q and then the Escape Key to 
return to the Main Menu.] 

AppleWorks 4 Data Base Bug 

Dear Cathleen, 

Here's a suggestion to my fellow NAUG members 
who use AppleWorks 4: 

Make certain to check your report layouts whenev-
er you delete a category from a data base file. """""' 
Under some circumstances, AppleWorks 4 will 
delete one or more categories from your report lay-
outs even though you did not delete that category 
from the data base. This applies to all versions of 
AppleWorks 4. 

Mitchell Bernstein 
Medford, New Jersey 
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Letters to NAUG ... 

Getting AW4 to Record Macros 

DearNAUG: 

I am running AppleWorks 4.2 with UltraMacros 
4.03 and cannot get the Inits to install. Nor can I 
record a macro. What's wrong? 

Marilyn Smith-Grant 
Ortonville, Michigan 

[Dan Crutcher replies: AppleWorks 4 comes con
figured to run on a minimal system. You have to 
turn on both the /nit Manager and TimeOut after 
you install the program. Press Apple-Q and 
Apple-S to access AppleWorks' Settings Menu and 
turn on these features. Then use the same menu to 
set the correct prefixes for your !nits and TimeOut 
applications. 

Your inability to record macros is an unrelated 
problem. If you update your copy of AppleWorks 
after you install UltraMacros, AppleWorks installs 
a new copy of SEG.UM, the AppleWorks 4 file that 
keeps track of UltraMacros. The new SEG.UM 
does not know that you installed UltraMacros, so 
it does not let you record macros or get to Debug. 
(Try pressing Apple-Control-X, which should 
launch Debug.) 

The solution is to copy your old SEG.UM file onto 
your AppleWorks directory, which over-writes the 
new copy of SEG.UM. This problem usually occurs 
when you upgradefromAW 4.0x toAW 4.3.] 

Quick Desktop Cleanup 

Dear Cathleen, 

Here's the fastest way yet for AppleWorks 3.0 and 
4.x users to clear all the files from their desktop: 

1. Press Apple-Q and then the Escape Key to 
return to the Main Menu. 

The National Apple Works Users Group (NAUG) is an 
association dedicated to supporting AppleWorks users. 
NAUG provides technical support and information about 
AppleWorks and enhancements to that program. Our pri
mary means of communicating with members is through 
the monthly newsletter entitled the Apple Works Forum. 

2. Select #4, "Remove files from the Desktop". 

3. Press Apple-Right Arrow to select all the files. 

4. Press Apple-Return to save all the new and 
changed files in their original directories and 
remove all the files from your desktop. 

Patricia Ann Daily 
Alma, Michigan 

Apple II as an Equity Computer 

DearNAUG: 

As affluent schools abandon their Apple II's for 
Macintosh and MS-DOS systems, large numbers of 
Apple II's are becoming available on the second
hand market. This is an opportunity for schools in 
low income areas, homeless shelters, adult literacy 
centers, children's hospitals, public libraries, and 
for ordinary working class families. 

See it right, and an exciting new era of educational 
computing is upon us. Steve Wozniak's dream to 
create a computer that anyone could afford is com
ing true before our eyes. 

NAUG members can play an important role in 
helping with this re-distribution of technology. The 
collective knowledge of NAUG's 5,000 members 
is fantastic. If each of us adopted a school, family, 
church-organization, homeless shelter, literacy cen
ter, or public library, the collected good we could 
bring about would be substantial. 

NAUG members can advise people on how to use 
their computers and where they can buy software, 
parts, peripherals, and supplies for their Apple II. 
They can help people learn to trouble-shoot broken 
computers, and help them understand how to put the 
programs that came with their computer to good use. 

All these things can happen. NAUG members can 
see to it that these computers get used in the best 
way possible. Wozniak's dream of the "micro-mil
lennium" is coming true. All it needs is a little 
nudging by you and me. 

Phil Shapiro 
Washington, DC 
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